Лабораторная работа №03 по дисциплине "Информатика и программирование модуль 2"

ТЕМА: Создание простых приложений с использованием визуальных компонентов.
----
ОСОБЕННОСТИ СОХРАНЕНИЯ ФАЙЛОВ ПРИ СОЗДАНИИ ПРИЛОЖЕНИЯ 
-----------------------------------------------------
1. При создании приложения с использованием визуальных компонентов 
(называемым часто просто приложением) имена сохраняемых в одной папке файлов (файла модуля и файла проекта) должны отличаться друг от друга, 
а также отличаться от имен, присваиваемых по умолчанию 
(для файла модуля - Unit1, для файла проекта - Project1 и т.п.), 
и должны по смыслу соответствовать действиям, выполняемым составляемой программой, или, по крайней мере, соответствовать 
номеру лабораторной работы и номеру программы в ней, 
(рекомендуется, чтобы имя модуля отличалось от имени проекта 
 цифрой в конце имени модуля, соответствующей номеру версии модуля).
2. При первоначальном сохранении файлов модуля и файлов проекта 
можно использовать любую команду сохранения 
из меню команды "File" окна Turbo Delphi. 
При необходимости сохранения уже сохраненных ранее файлов модуля и файлов проекта, например, в другой папке с теми же или другими именами, 
следует использовать в окне Turbo Delphi 
для файлов модуля команду "File => Save As...", 
для файлов проекта – команду"File => Save Project As..."
3. ПРИ СОЗДАНИИ ПРИЛОЖЕНИЙ С ИСПОЛЬЗОВАНИЕМ ВИЗУАЛЬНЫХ КОМПОНЕНТОВ 
(ПРИ ВЫПОЛНЕНИИ ЭТОЙ И СЛЕДУЮЩИХ ЛАБОРАТОРНЫХ РАБОТ) 
ДЕЙСТВУЙТЕ АНАЛОГИЧНО ПУНКТАМ 1 И 2 ЭТОЙ РАБОТЫ.

СОЗДАНИЕ ПРОСТЕЙШИХ ПРОЕКТОВ ПРИЛОЖЕНИЙ 
---------------------------------------
4. Для перехода к созданию проекта приложения с использованием визуальных 
                                                            компонентов 
в окне Turbo Delphi 
  в правом нижнем углу этого окна во внутреннем окне "Tool Palette" 
                                     на вкладке "Delphi Projects" 
                                     выберите строку "VCL Forms Application", 
 (или выполните команды 
               "File => New => VCL Forms Application – Delphi for Win32", 
  или нажмите на панели инструментов "Standard" кнопку "New items", 
      и затем в появившемся окне "New Items" в категории "Delphi Projects" 
                            выберите значок "VCL Forms Application") 
  после чего на экране должно появиться окно проекта создаваемого приложения.

5. После перехода к созданию проекта в окне Turbo Delphi 
в его центральной части обычно появляется окно модуля (обычно с именем Unit1) 
с открытой вкладкой Design (ярлычок вкладки находится внизу справа) 
на которой находится форма (обычно с заголовком Form1) – заготовка 
                                                         окна приложения.
6. Работа по созданию проекта обычно начинается с выбора 
и рисования на форме с помощью указателя "мыши" компонентов 
(кнопок, полей, списков и т.д.) с вкладок внутреннего окна "Tool Palette", расположенного обычно в правом нижнем углу окна Turbo Delphi, 
и затем эта работа продолжается 
размещением на форме этих компонентов, 
изменением их размеров, 
установкой значений свойств этих компонентов, 
созданием процедур обработки событий (обработчиков событий), 
                             связанных с этими компонентами.

7. Для выбора или, иначе говоря, выделения одного из размещенных в окне формы компонентов (включая также и форму) можно использовать 
одиночные щелчки левой кнопкой "мыши" 
          или на указанном компоненте непосредственно в окне формы, 
          или на значке компонента в окне "Structure", 
а также использовать выбор из списка в окне "Object Inspector".

8. Для доступа к свойствам выбранного компонента можно использовать вкладку "Properties" ("Свойства") в окне "Object Inspector" 
(способ отображения имен свойств можно менять в контекстном меню этой вкладки командами "Arrange => by Name" – отображение в алфавитном порядке, 
"Arrange => by Category" – отображение по категориям).
9. Для того чтобы в процессе выполнения созданной программы размещенный в окне формы компонент мог реагировать на то или иное событие, 
необходимо создать или выбрать процедуру обработки этого события, 
которая при возникновении этого события будет вызываться и выполняться. 
Для создания процедуры обработки события следует: 
    выделить компонент; 
    в окне "Object Inspector" открыть вкладку "Events" ("События"); 
    выбрать событие; 
    выполнить двойной щелчок в области значения выбранного события 
                            (правее названия этого события). 
В результате этих действий в окне модуля на вкладке "Code" 
автоматически создается заготовка процедуры обработки выбранного события. 
При этом открывается и переходит на передний план вкладка "Code" окна модуля, а курсор устанавливается в то место процедуры обработки события, где программистом должны быть написаны операторы, 
выполняемые при возникновении соответствующего события. 
Пример заготовки процедуры обработки события нажатия на кнопку Button1: 
procedure TForm1.Button1Click(Sender: TObject); 
begin 

end; 
Для выбора ранее созданной процедуры обработки события следует: 
    выделить компонент; 
    в окне "Object Inspector" открыть вкладку "Events" ("События"); 
    выбрать событие; 
    в области значения выбранного события в раскрывающемся списке 
      выбрать имя ранее созданной процедуры обработки события 
(при необходимости перехода в эту процедуру можно после ее выбора 
     выполнить двойной щелчок в области значения выбранного события, 
     где будет находиться имя выбранной процедуры).
10. Программирование, таким образом, в значительной степени сводится 
к созданию и выбору процедур обработки тех событий, 
которые могут происходить с компонентами, в том числе и с самой формой.

11. В процедурах обработки событий могут использоваться операторы, 
при выполнении которых используются или меняются значения свойств компонентов, например: 
Label1.Caption:='Группа ЗБГР-11'+Label2.Caption; 
(в этом примере выполняется объединение текстовой константы 
и текстового значения свойства Caption компонента Label2), 
причем в процедурах обработки событий для самой формы имя формы можно 
не указывать, например: 
Form1.Color:=clRed;   или   Color:=clRed; 
Некоторые свойства, называемые свойствами времени выполнения программы, 
могут отсутствовать в окне "Object Inspector", но значения этих свойств 
также могут меняться и использоваться в процедурах обработки событий.

12. В процедурах обработки событий могут также использоваться так называемые методы (процедуры, имеющие отношение к тому или иному компоненту). 
Например, для закрытия формы может использоваться метод Close: 
Form1.Close;   или   Close;
СОЗДАНИЕ ПРОГРАММ 
-----------------

13. ПРИ СОЗДАНИИ ПРИЛОЖЕНИЙ С ИСПОЛЬЗОВАНИЕМ ВИЗУАЛЬНЫХ КОМПОНЕНТОВ 
(ПРИ ВЫПОЛНЕНИИ ЭТОЙ И СЛЕДУЮЩИХ ЛАБОРАТОРНЫХ РАБОТ) 
ДЕЙСТВУЙТЕ АНАЛОГИЧНО ПУНКТАМ 1 И 2 ЭТОЙ РАБОТЫ, 
А ТАКЖЕ ИЗМЕНЯЙТЕ ИМЕНА В ЗАГОЛОВКАХ ОКОН ЭТИХ ПРИЛОЖЕНИЙ 
      И ИМЕНА ОБЪЕКТОВ В ЭТИХ ОКНАХ ТАК, 
ЧТОБЫ ИМЕНА ОТЛИЧАЛИСЬ ОТ СТАНДАРТНЫХ ИМЕН (Form1, Button1 и т.д.) 
И ПО ВОЗМОЖНОСТИ СООТВЕТСТВОВАЛИ НАЗНАЧЕНИЮ ЭТИХ ОКОН И ОБЪЕКТОВ.
14. ПРИ ВЫПОЛНЕНИИ ЭТОЙ И СЛЕДУЮЩИХ ЛАБОРАТОРНЫХ РАБОТ 
при изменении в окне Turbo Delphi состава и взаимного расположения 
внутренних окон можно восстановить 
первоначальный состав и взаимное расположение этих окон, 
используя в строке меню окна Turbo Delphi 
раскрывающийся список "Desktop speedsetting" 
и выбирая в этом списке значение "Default Layout".
   ПРОГРАММА 3-1 
   -------------

15. Создайте проект и разместите в форме надпись (TLabel) и две кнопки (TButton) 
   с вкладки Standard окна "Tool Palette" 
   (в заголовке окна должен быть текст "Группа и ФИО",

    текст надписи должен быть крупным и хорошо видимым в форме, 
    на одной и кнопок должна быть надпись "Группа", на другой - "ФИО").
   Используйте для изменения текста в заголовке окна, текста надписи, 
   текстов на кнопках свойство Caption соответствующих компонентов; 
   для изменения размера, начертания и цвета шрифта текста надписи – 
   ее свойство Font и его подсвойства Size, Style и Color.
   Создайте такие процедуры обработки событий OnClick нажатий на кнопки,
   чтобы после запуска программы на месте первоначально пустой надписи 
   при нажатии на кнопки появлялись бы, соответственно, 
   номер Вашей группы или Ваша фамилия с инициалами (см. рисунок 15-1).
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Рисунок 15-1
16. ПРИ ВЫПОЛНЕНИИ ЭТОЙ И СЛЕДУЮЩИХ ЛАБОРАТОРНЫХ РАБОТ 
для использования при запуске приложения (или его выполняемого файла) возможности появления заголовка, отличающегося от имени выполняемого файла 
                            (которое может быть только с латинскими буквами),
на кнопке этого приложения на панели задач Windows 
следует в окне Turbo Delphi выполнить команды "Project => Options... ", 
затем в появившемся окне "Project Options for... " 
слева в списке выбрать строку с "Application" и затем 
справа вверху в поле "Title:" ввести заголовок (можно и на русском языке), который будет появляться на кнопке этого приложения на панели задач Windows. 
Затем можно также соответственно переименовать выполняемый файл 
этого приложения и запускать его независимо от среды программирования.
   ПРОГРАММА 3-2 
   -------------

17. Создайте проект и разместите в форме с заголовком "СКОРОСТЬ" 
   следующие компоненты, как показано на рисунке 17-1 
   (для Текстовых полей используйте компонент TEdit с вкладки Standard 
    окна "Tool Palette" и у этого компонента свойство BiDiMode 
    для выравнивания данных, вводимых в текстовое поле, по его правому краю).
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                                  Рисунок 17-1
   Тексты надписей: для Надписи1 - "РАССТОЯНИЕ", для Надписи2 - "ВРЕМЯ", 
   для Надписи3 - "СКОРОСТЬ: " должны быть крупными и хорошо видимыми в форме. 
   На Кнопке1 должен быть текст "ВЫЧИСЛИТЬ", на Кнопке2 – "ВЫХОД".
   Текстовые поля первоначально должны быть пустыми 
   (используйте свойство Text компонента TEdit).
   Для кнопки "ВЫЧИСЛИТЬ" создайте выполняющую следующие действия 
   процедуру обработки нажатия на эту кнопку: 
а) преобразование текстовых (строковых) значений свойства Text 
   Текстового поля1 (для скорости) и Текстового поля 2 (для времени) 
   в соответствующие вещественные значения с использованием функции StrToFloat, 
   например, для расстояния это может выглядеть как s:=StrToFloat(Edit1.Text); 
б) вычисление вещественного значения скорости 
   по вещественным значениям расстояния и времени; 
в) преобразование вещественного значения скорости 
   в текстовое (строковое) значение с использованием функции FloatToStr 
   и добавление этого значения 
   к первоначальному тексту Надписи3 в виде текста справа: 
   Label3.Caption:='СКОРОСТЬ: '+FloatToStr(v);

   Для кнопки "ВЫХОД" создайте процедуру обработки нажатия на эту кнопку 
   для выхода из программы или, иначе говоря, для закрытия формы 
   (используйте метод Close).
   Отредактируйте созданную программу таким образом, чтобы она реагировала 
   на ввод нулевого значения в Текстовое поле2 после нажатия кнопки ВЫЧИСЛИТЬ 
   добавлением к первоначальному тексту Надписи3 текста 
   'ВРЕМЯ НЕ ДОЛЖНО БЫТЬ РАВНО 0!'
18. Следует принимать во внимание 
(ПРИ ВЫПОЛНЕНИИ ЭТОЙ И СЛЕДУЮЩИХ ЛАБОРАТОРНЫХ РАБОТ), 
что функции StrToFloat и FloatToStr (и аналогичные им функции) 
в качестве разделителя целой и дробной части вещественного числа используют разделитель, установленный при настройке региональных параметров операционной системы (для русскоязычной версии Windows это по умолчанию запятая).
   ПРОГРАММА 3-3
   -------------

19. Создайте проект с пустой формой с заголовком "Цвета". 
   Создайте процедуры обработки событий при щелчках в области окна формы 
   для изменения цвета формы 
   (цвет формы определяется значением ее свойства Color) 
   после запуска приложения следующим образом:
   при одиночных щелчках левой кнопкой "мыши" (событие формы OnClick)- 
       с первоначального цвета формы - на красный цвет, 
       с красного на желтый, с желтого на зеленый, с зеленого на красный, 
       снова с красного на желтый и т.д.; 
   при двойном щелчке левой кнопкой "мыши" (событие формы OnDblClick) - 
       с любого цвета на первоначальный цвет формы.

   ПРОГРАММА 3-4   НАЧАЛО 
   -------------   ------
20. Сохраните файлы модуля и проекта ПРОГРАММЫ 3-3 
   в другой папке с другими именами. 
   Добавьте в форму сохраненного проекта 
  (с возможным изменением размеров этой формы) с вкладок окна "Tool Palette" 
   следующие компоненты в соответствии с Рисунками 20-1 и 20-2:

   флажок (компонент TCheckBox с вкладки Standard); 
   переключатели или радиокнопки (компонент TRadioButton с вкладки Standard). 
   После добавления флажка и переключателей при необходимости растягивайте 
   область каждого из этих компонентов вправо для полного появления 
   рядом с ними значений их свойств Caption (которые должны быть изменены 
   в соответствии с рисунком 20-2).
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                      Рисунок 20-1          Рисунок 20-2   
   Компоненты TRadioButton в окне формы 
   образуют группу взаимозависимых компонентов, 
   то есть если один из них установить в выбранное состояние 
   (с черной точкой внутри) с присвоением его свойству Checked значения True 
   (в том числе и программным путем), то значение этого свойства 
   у других компонентов группы автоматически становится равным False.

   При запуске приложения окно формы должно иметь вид (и цвет по умолчанию),
   как на рисунке 20-3, на котором флажок "Изменение цвета" сброшен 
   (значение его свойства Checked в таком случае равно False).

   При сброшенном флажке переключатели недоступны (значение свойства Enabled 
   для них всех в таком случае равно False), и, кроме того, 
   щелчки левой кнопкой "мыши" в окне формы не должны менять ее цвет.
   ПРОГРАММА 3-4   ОКОНЧАНИЕ 
   -------------   ---------

   При установке флажка "Изменение цвета", как на рисунке 20-4 
   (значение свойства Checked флажка в таком случае равно True), 
   переключатели доступны для выбора 
   (значение свойства Enabled для них всех в таком случае равно True), и 
   кроме того, щелчки левой кнопкой "мыши" в окне формы должны менять ее цвет.
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                       Рисунок 20-3          Рисунок 20-4   
   При установленном флажке "Изменение цвета" выбор того или иного 
   переключателя должен приводить к изменению цвета окна формы 
   в соответствии с названием цвета рядом с переключателем, 
   кроме того, щелчки левой кнопкой "мыши" в окне формы должны менять ее цвет 
   и приводить к выбору соответствующего переключателя 
   присвоением его свойству Checked значения True.
   Для флажка CheckBox1 создайте процедуру обработки события OnClick, 
   которое происходит при установке или сбросе флажка. 
   В процедуре обработки этого события следует присвоить свойству Enabled 
   для всех переключателей значение свойства Checked флажка, 
   так как при установке или сбросе флажка его свойство Checked 
   приобретает новое значение еще до входа в процедуру обработки этого события.
   Для каждого из компонентов TRadioButton создайте свою процедуру 
   обработки события OnClick (происходящего при выборе компонента), при 
   выполнении которой должно происходить соответствующее изменение 
   цвета окна формы, за исключением компонента "По умолчанию", 
   для которого можно выбрать процедуру обработки события формы OnDblClick. 

   В начале каждой из уже имеющихся процедур обработки событий формы 
   (OnClick и OnDblClick) добавьте проверку значения свойства Checked флажка 
   "Изменение цвета" так, чтобы при выполнении этих процедур изменение цвета 
   окна формы происходило бы только при равном True значении этого свойства.
   В процедуре обработки события формы OnClick закомментируйте операторы 
   присвоения значения цвета окна формы (ее свойству Color) и затем вместо них 
   (слева перед каждым из закомментированных операторов) 
   добавьте оператор присвоения значения True свойству Checked переключателя, 
   соответствующего этому цвету (указанному в закомментированном операторе). 
   При этом изменение цвета окна формы произойдет в процедуре обработки события 
   OnClick соответствующего переключателя, так как при изменении значения 
   свойства Checked переключателя программным путем также происходит переход 
   к процедуре обработки события OnClick этого переключателя.
   В процедуре обработки события формы OnDblClick добавьте оператор присвоения 
   значения True свойству Checked переключателя, соответствующего цвету 
   по умолчанию, и оставьте оператор присвоения значения цвета по умолчанию 
   окну формы, так как эта процедура является также процедурой обработки 
   события OnClick переключателя, соответствующего цвету по умолчанию.
   ПРОГРАММА 3-5   НАЧАЛО 
   -------------   ------
21. Сохраните файлы модуля и проекта ПРОГРАММЫ 3-3 
   в другой папке с другими именами 
   (но не в той, где были сохранены файлы модуля и проекта ПРОГРАММЫ 3-4). 
   Добавьте в форму сохраненного проекта 
  (с возможным изменением размеров этой формы) с вкладок окна "Tool Palette" 
   следующие компоненты в соответствии с Рисунками 21-1 и 21-2:

   флажок (компонент TCheckBox с вкладки Standard); 
   таймер (компонент TTimer с вкладки System) – в любое место формы; 
   текстовое поле (компонент TEdit с вкладки Standard) – используйте у этого 
                   компонента свойство BiDiMode для выравнивания данных, 
                   вводимых в текстовое поле, по его правому краю; 
   кнопка-счетчик (компонент TUpDown с вкладки Win32) – после размещения этого 
          компонента следует для его свойства Associate выбрать значение, 
          совпадающее с именем текстового поля, после чего компонент станет 
          связанным с текстовым полем, 
          переместится к нему и будет находиться рядом с ним.
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                Рисунок 21-1                Рисунок 21-2         

   Для компонента TTimer установите начальное значение его свойства Enabled 
   равным False (при этом таймер пока не будет работать).
   Для компонента TUpDown установите следующие начальные значения его свойств: 
   Position – 500, Increment – 100, Min – 0, Max – 3000 
   (здесь Min, Max – соответственно нижняя и верхняя граница изменения 
    значения свойства Position, Increment – шаг изменения значения 
    свойства Position при нажатиях на кнопки этого компонента).
   При запуске приложения окно формы должно иметь вид (и цвет по умолчанию),
   как на рисунке 21-3, на котором флажок 
   "Изменение цвета с интервалом времени" сброшен 
   (значение его свойства Checked в таком случае равно False).

   При сброшенном флажке щелчки левой кнопкой "мыши" в окне формы 
   должны менять ее цвет.
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Рисунок 21-3
   При установке флажка "Изменение цвета с интервалом времени" 
   форма должна начать менять свой цвет в циклическом режиме 
   с интервалом времени в миллисекундах, отображаемым в поле TEdit 
   и задаваемым значением свойства Position компонента TUpDown 
   (при этом должны появляться те же цвета и в том же порядке, 
    как и при одиночных щелчках левой кнопкой "мыши" в окне формы).
   При установленном флажке щелчки левой кнопкой "мыши" в окне формы 
   также должны менять ее цвет.

   ПРОГРАММА 3-5   ОКОНЧАНИЕ 
   -------------   ---------

   Для флажка CheckBox1 создайте процедуру обработки события OnClick, 
   которое происходит при установке или сбросе флажка. 
   В процедуре обработки этого события следует 
   присвоить свойству Enabled таймера значение свойства Checked флажка, 
   так как при установке или сбросе флажка его свойство Checked 
   приобретает новое значение еще до входа в процедуру обработки этого события.

   Для реализации изменения цвета формы с заданным интервалом времени 
   должен использоваться таймер. 
   Свойство Interval таймера задает продолжительность интервала времени 
   в миллисекундах, по истечении которого происходит событие OnTimer 
   (если значение свойства Interval равно нулю, то таймер перестает работать).

   Свойство Enabled таймера при значении True разрешает произойти 
   событию OnTimer, при значении False это событие не сможет произойти. 
   В качестве процедуры обработки события OnTimer 
   выберите процедуру обработки события формы OnClick.
   Для кнопки-счетчика – компонента TUpDown, создайте процедуру обработки 
   события OnClick (происходящего при нажатиях на кнопки компонента), в которой 
   свойству Interval таймера присваивается 
   значение свойства Position компонента TUpDown.
ОТЧЕТ О ВЫПОЛНЕНИИ РАБОТЫ, ЕСЛИ БЫ ПРИСУТСТВОВАЛ ПРЕПОДАВАТЕЛЬ 
--------------------------------------------------------------
22. Продемонстрируйте тексты созданных программ, а также их выполнение в среде

   программирования и независимо от нее.

________________________________________________________________________________

